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Introduction

Welcome and thank you for choosing a TOSHIBA product.

For your convenience, your TOSHIBA product is furnished with two 
guides:
   a) a Quick Start Guide, and
   b) a comprehensive PDF User’s Manual on the included CD.
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Section 1 
 Getting to Know Your Camcorder

Overview

The Camcorder with 5 Mega Pixel sensor and 5X Optical Zoom Lens can take H.264 movies. By way 
of using H.264 technology, more videos can be taken within certain amount of memory. High quality 
images with up to 8 mega-pixels can also be delivered smoothly. With a color LCD monitor, users can 
compose images and examine them easily.

The Camcorder also features  movie recording at HD resolution of 1080p. You can also connect it to an 
HDTV via HDMI cable, and easily playback recorded high-definition videos on the wide screen HDTV. 

Exposure and color balance can either be adjusted automatically or allowed to be changed manually. An 
2x/4x zoom increases user control over the movies and pictures you take. 

Built-in memory allows you to take pictures and movies without memory card. The memory card slot 
allows users to increase the storage capacity.

 Note
Partial memory of the built-in memory is used for Firmware code.

Check the Components

Unpack the package and make sure all standard accessories listed are included:
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Safety Instructions

1. Do not drop, puncture or disassemble the camcorder; otherwise the warranty will be voided.

2. Avoid all contact with water, and dry hands before using.

3. Do not expose the camcorder to high temperature or leave it in direct sunlight. Doing so may 

    damage the camcorder.

4. Use the camcorder with care. Avoid pressing hard on the camcorder body.

5. For your own safety, avoid using the camcorder when there is a storm or lightning.

6. Do not use batteries of different specifications. Doing so may lead to the potential for serious

     damage.

7. Remove the battery during long periods between usage, as a deteriorated battery may

     affect the functionality of the camcorder.

8. Remove the battery if it shows signs of leaking or distortion.

9. Use only the accessories supplied by the manufacturer.

10. Keep the camcorder out of the reach of infants.

11. Risk of explosion if battery is replaced by an incorrect type.

12. Dispose of used batteries according to the instructions.

System Requirements

Microsoft Windows 2000/XP/Vista• 

Intel Pentium III 800MHz or above• 

256 MB RAM• 

CD-ROM Drive• 

700 MB free HDD space• 

Available USB port• 

16-bit Color Display• 

 Note
The LCD screen is manufactured using extremely high-precision technology. However, some

tiny black and/or bright dots (white, red, blue or green) may appear on the LCD screen.

These dots are a normal result of the manufacturing process, and do not affect the recording. 
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Section 2 
 Getting Started

Loading the Battery

Before using the camcorder, users must load Lithium-ion 
rechargeable battery

Insert the battery following to the correct polarity marks 1. 
( + or -).

Close the battery cover firmly.2. 

Inserting and Removing an SD Card (Optional)

The camcorder comes with internal memory which allows you to store pictures and movies. You can

expand the memory capacity by using an optional SD memory card. 

Insert the memory card into the right position. Please 1. 
refer to the figure.

To remove an installed SD card, press the card inwards 2. 
to release it.

When the card pops out, gently remove it from its slot.3. 

Recommended memory capacity: 1GB or above.4. 

 Note
When a memory card is fitted, movies/pictures are saved on card rather than on the built-in • 
memory.

Protecting Data on an SD Card: SD card is read-only by locking the SD card. No pictures •	
and movies can be recorded when the SD card is locked. Make sure the lock is on writeable 
position before recording any media.

Writeable 
position

Write-Protected 
Position
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Turning the Camcorder On and Getting Started

• To turn on the Camcorder: Flip out the LCD panel or press Power Button for one second. When the

Camcorder is turned on, the green LED will light up.

• To take a movie, press the Movie Shutter Button (  ).

• To take a picture: Press the Picture Shutter Button (  ) halfway down till the focusing frame turns

from white to green. Then, press the Picture Shutter Button fully down to take picture.

Focusing Frame: White Focusing Frame:Green 

.

• To view stored movies, pictures, press Record/Play Button (  ) once to switch to Playback Mode.

Press a second time to return to Record Mode.

Turning the Camcorder Off

To turn off the Camcorder, you can either press the Power Button for one second, or you can place • 
the LCD panel back to its original position.
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Section 3 
Record Mode

Button Function

Direction Button

Right Button: HD(1080p) / VGA mode switch

Left Button: Light ON / OFF

Menu/OK Button: Menu On / Validate the setting

Tele (Up) Button : Zoom In

Wide (Down) Button : Zoom out

Power Button: Press down for one second to turn on or turn 
off the Camcorder

RECORD/PLAY Button functions: 

Switch between Record /Playback Mode1. 

Return to the previous page2. 

For quick review, press it after recording3. 

Movie Shutter Button: 

Start to take movie.1. 

To stop recording, press it again.2. 

Picture Shutter Button: Start to take picture.
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LCD Monitor Information

The indicators shown below may display on LCD when movies and pictures are recorded:

(1)

Movie Resolution

HD (1080p) (30fps)

HD (720p) (30fps)

WVGA (60fps)

VGA (30fps)

QVGA (30fps)

Picture Resolution 

High

Standard

Low

(2)
Number of images that can still be taken at current resolution

Recording time of movie that can still be taken at current resolution

(3) Light On

(4) Self-timer enabled
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(5)

Scene

Skin

Night

Backlight

(6) Macro Position Focusing

(7) Exposure compensation value

(8) Manual White Balance

(9) SD Card inserted

(10)

Battery: full power

Battery: medium power

Battery: low power

Battery: power empty

(11)

Zoom meter:

HD(1080p):1X~10X (5X Optical + 2X Digital)

Other video resolution:1X~20X (5X Optical + 4X Digital)

(12) Stabilization

 Note
Scene: B/W / Classic / Nagative effect can be previewed immediately without indicator on the LCD

Movie Recording

Press Movie Shutter button (•   ) to start recording. When a movie is recording, a time indicator will 
display on LCD monitor. To stop recording, press Movie Shutter Button (  ) again. 

Press RECORD/PLAY Button to view the recorded movie.• 

Five resolution settings are available: • 

Video Quality

HD (1080p) (30fps)

HD (720p) (30fps)

WVGA (60fps)

VGA (30fps)

QVGA (30fps)
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Picture Recording

Press the Picture Shutter Button ( •  ) halfway down till the focusing frame turns from white to 
green. Then, press the Picture Shutter Button fully down to take picture.

Press RECORD/PLAY Button to view the picture.• 

Three resolution settings are available: • 

Image Quality 

  High Quality:8 Mega Pixels 

  Standard Quality:5 Mega Pixels

   Low Quality:3 Mega Pixels

Taking Close up Pictures

The Camcorder has one close-up picture mode to allow you to take pictures at close range. The Macro

Mode (  ) should be used for objects located within 80 cm.

To take close-up pictures:

Operation Display Screen

In Effect Mode Submenu, press Up/Down Button 1. 
to select Macro.

Use Right/Left Buttons to choose Macro or 2. 
Normal. 

Press Menu/OK Button to validate the setting. 3. 

Using Zoom

The zoom magnifies images, when recording movies or taking pictures.• 

To zoom in/out, press the Tele/Wide Button.1. 

The  zoom can be set as 1X~10X (5X Optical + 2X Digital) / 1X~20X (5X Optical + 4X Digital).2. 
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Options for Record Menu

Movie Mode Picture Mode Effect

Resolution• 

Stabilization• 

Resolution • 

Self-timer• 

Light• 

Macro• 

Scene• 

Exposure• 

White Balance• 

Operations for Record Mode 

Operation Screen

Press Menu/OK Button when in Record Mode.1. 

Use Right/Left Buttons to move between main menu 2. 
options, which are Movie Mode, Picture Mode, Effect, 
and Setting. 

Press Down Button to enter the folder of main option 3. 
you select.

Press Right/Left button to select the setting options, 4. 
then press Menu/OK button to validate.

Press RECORD/PLAY button to exit.5. 
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Movie Mode Submenu Setting

Operation Display Screen

In Record Mode, press Menu/OK Button to enter 1. 
record menu screen. 

Use Right/Left Buttons to select Movie Mode.2. 

The Movie Mode Submenu contains 2 options.3. 
Resolution and Stabilization, for you to adjust 
the camcorder setting. 

Movie Resolution

Operation Display Screen

In Movie Mode Submenu, press Down button to 1. 
enter Resolution.

Use Right/Left Buttons to move between five 2. 
settings.

Press Menu/OK Button to validate the setting.3. 

Stabilization

Operation Display Screen

In Movie Mode Submenu, press Down button to 1. 
enter Stabilization.

Use Right/Left Buttons to choose On or Off.2. 

Press Menu/OK Button to validate the setting.3. 

 Note
Stabilization doesn’t support HD(1080p) and WVGA/60fps.
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Picture Mode Submenu Setting

Operation Display Screen

In Record Mode, press Menu/OK Button to enter 1. 
record menu screen.

Use Right/Left Buttons to select Picture Mode.2. 

The Movie Mode Submenu contains 2 options, 3. 
Resolution, and Self-timer, for you to adjust the 
camcorder setting.

Picture Resolution

Operation Display Screen

In Picture Mode Submenu, press Down button 1. 
to enter Resolution.

Use Right/Left Buttons to move between three 2. 
settings.

Press Menu/OK Button to validate the setting.3. 

Self-timer (Picture Record Mode Only)
The self-timer allows you to take pictures with a ten-second self-timer. The Light on the front of the 
camcorder will also blink. The speed of blinking will increase just before the picture is taken.

Operation Display Screen

In Picture Mode Submenu, press Up/Down Button 1. 
to select Self-timer.

Use Right/Left Buttons to choose On or Off. 2. 

Press Menu/OK Button to validate the setting.3. 
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Effect Submenu Setting

Operation Display Screen

In Record Mode, press Menu/OK Button to enter 1. 
record menu screen.

Use Right/Left Buttons to select Effect.2. 

The Effect Submenu contains3.  5 options, Light, 
Macro, Scene, Exposure, and WB, for you to 
adjust the camcorder setting.

Light

To enable the light by either hot key (Left Button) or select from the effect menu.

On ( •  ): The light will be turned on and keeps providing light in the low light environment

Off: The light is turned off• 

Operation Display Screen

In Effect Mode Submenu, press Up/Down Button 1. 
to select Light. 

Use Right/Left Buttons to choose On or Off.2. 

Press OK Button to validate the setting.3. 

 Note
The light will be disabled automatically when battery power is low (  ).

Macro

The Camcorder has one close-up picture mode to allow you to take pictures at close range. The Macro

Mode (  ) should be used for objects located within 80 cm.

Operation Display Screen

In Effect Mode Submenu, press Up/Down Button 1. 
to select Macro.

Use Right/Left Buttons to choose Macro or 2. 
Normal. 

Press Menu/OK Button to validate the setting.3.  
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Scene

You can select the mode according to the scene condition.

Auto: • Shoot without any special effect on the image.

Skin: • Shoot with an effect that makea skin tones more natural 

Night• : Use Night mode for night scenes or low light conditions.

Backlight:•  You can take shots when bright light is behind the subject.

B/W:•  The image is converted to black-and-white.

Classic: • The image is converted to sepia look.

Negative: • The image is converted as the negative of the normal.

Operation Display Screen

In Effect Submenu, press Down button to enter 1. 
Scene.

Use Right/Left Buttons to move between 7 2. 
settings.

Press OK Button to validate the setting.3. 

 Note
To	avoid	blurry	pictures,	place	the	Camcorder	on	a	flat,	steady	surface,	or	use	a	tripod	when	take	
shots in Night mode.

Exposure

The camcorder adjusts image exposure automatically. In certain circumstances you may wish to adjust 
the exposure compensation setting.

Operation Display Screen

In Effect Submenu, press Down button to select 1. 
Exposure.

Use Right/Left Buttons to choose preferred 2. 
EV(Exposure Value). The change can be 
previewed immediately.

Press OK Button to validate the setting.3. 
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WB (White Balance)

The camcorder adjusts the color balance of images automatically. Three manual white balance settings 
are available:

Auto: • The camcorder automatically adjusts white balance.

Daylight: • Under outdoors.

Fluorescent: • Under fluorescent light condition.

Tungsten: • Under tungsten light condition.

Operation Display Screen

In Effect Submenu, press Down button to select 1. 
WB.

Use Right/Left Buttons to move between 2. 
four settings. The change can be previewed 
immediately.

Press OK Button to validate the setting.3. 
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Section 4 
Playback Mode

Button Function

The Buttons have the following functions in Movie and Picture Playback Modes. 

  

Direction Button

Right Button: Go to the next movie/picture. Fast forward 

Left Button: Go to the previous movie/picture. Fast rewind

Menu/OK Button: Enter to movie or picture option menu / 
Validate setting.

Tele (Up) Button : Zoom in / Volume increase

Wide (Down) Button : Zoom out / Volume decrease

RECORD/PLAY Button functions: 

Switch between Record and Playback modes.1. 

Return to the previous page.2. 

Movie Shutter Button:

Start playing the recorded movie.
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LCD Monitor Information

Indicators on the LCD screen while in Playback Mode:

(1)

HD (1080p) (30fps)

HD (720p) (30fps)

WVGA (60fps)

VGA (30fps)

QVGA (30fps)

High

Standard

Low

(2) Movie playback time counter

(3) Indicate the selected movie/picture is locked.

(4) Current Number/ Total number of movie or picture.

(5) Volume

(6) Indicate the screen is in movie playback mode:Play/Pause

(7) Magnification Indicator.
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Operations for Playback Mode 

The Playback Mode is for viewing and managing movies and pictures on the built-in memory or on an 
SD card.

Operation Display Screen

Press RECORD/PLAY Button ( 1.  ) to switch 
from Record Mode to Playback Mode Main 
Menu.There are 2 options in the Playback Mode, 
Movie and Picture.

Press Direction Button to select the specific 2. 
option.

Press Menu/OK Button to enter Movie/ Picture  3. 
thumbnail preview folder.

Use direction buttons to locate the movies/4. 
picture you want to view.

Press Menu/OK button to view the movies/5. 
picture.

Movie Playback

Operation Display Screen

In movie thumbnail preview folder, use direction 1. 
buttons to locate the movies you want to view.

Press Menu/OK button to play the movies.2. 

While playing movie, press Right/Left Buttons to 3. 
fast forward/rewind, then release the button to 
stop.

Use Up/Down Buttons to adjust volume.4. 
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Movie Playback Mode Menu

Operation Display Screen

In Movie Playback Mode, press Menu/OK Button 1. 
to enter Movie Playback menu screen.

.Use Up/Down Buttons to select four options, 2. 
Delete, Lock, Repeat One, and Repeat All.

Delete Movies

Operation Display Screen

Use Up/Down Buttons to select the Delete option. 1. 
.

Press Menu/OK Button to go to the Delete menu.2. 

Use Right/Left Buttons to select the movie.3. 

Use Up Button to delete all movies or Down Button 4. 
to delete single movie. Or Press RECORD/PLAY 
Button to exit.

Before a movie is deleted, a confirmation screen 5. 
will appear; choosing “Yes” will execute the 
operation and “No” will cancel the operation.

Press Menu/OK Button to validate the setting. 6. 

 Note
If a memory card is inserted, you can delete only those movies stored on the card. •	

Movies on a written-protected memory card cannot be deleted.•	

The delete function will only erase unlocked movies. Locked movies must be unlocked before •	
being deleted. 
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Lock Movies

Single or all movies can be locked. This function can prevent the movies from being deleted 
accidentally. 

Operation Display Screen

Use Up/Down Buttons to select the Lock option.1. 

Press Menu/OK Button to go to the Lock menu. 2. 

Use Right/Left Buttons to select the movie.3. 

Use Up Button to lock/unlock all movies or Down 4. 
Button to lock/unlock single movie.

Press RECORD/PLAY Button to exit.5. 

Repeat Movies

This function automatically repeats playing single movie or all movies in order. 

Operation Display Screen

Use Up/Down Buttons to select the Repeat One 1. 
option or Repeat All option. 

Press Menu/OK Button to start repeating, press it 2. 
again to stop and return to the previous page. 
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Picture Playback

Operation Display Screen

In Picture thumbnail preview folder, use direction 1. 
buttons to locate the picture you want to view.

Press Menu/OK button to view the picture.2. 

Use Right/Left Buttons to go to the next or last 3. 
picture.

While the picture is selected, use Tele Button to 4. 
magnify.

To navigate the magnified picture, press OK Button 5. 
to enter navigation mode(The inner Magnification 
Indicator turns orange). Use Direction Buttons to 
navigate the magnified picture. Press OK Button 
again to exit navigation mode.
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Picture Playback Mode Menu

Operation Display Screen

In Picture Playback Mode, press Menu/OK Button 1. 
to enter Picture Playback menu screen.

Use Up/Down Buttons to select three options, 2. 
Delete, Lock, and Slideshow.

Delete Picture

Operation Display Screen

Use Down Buttons to select the Delete option.1. 

Press Menu/OK Button to go to the Delete menu. 2. 

Use Right/Left Buttons to select the picture.3. 

Use Up Button to delete all pictures or Down 4. 
Button to delete single picture.Or Press RECORD/
PLAY Button to exit.

Before a picture is deleted, a confirmation screen 5. 
will appear; choosing “Yes” will execute the 
operation, “No” will cancel the operation. 

Press Menu/OK Button to validate the setting.6. 

 Note
If a memory card is inserted, you can delete only those pictures stored on the card. •	

Pictures on a written-protected memory card cannot be deleted.•	

The delete function will only erase unlocked pictures. Locked pictures must be unlocked before •	
being deleted. 
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Lock Pictures

Single or all pictures can be locked. This function can prevent the pictures from being deleted 
accidentally. 

Operation Display Screen

Use Up/Down Buttons to select the Lock option.1. 

Press Menu/OK Button to go to the Lock menu. 2. 

Use Right/Left Buttons to select the picture.3. 

Use Up Button to lock/unlock all pictures or Down 4. 
Button to lock/unlock single picture. 

Press RECORD/PLAY Button to exit.5. 

Make Slide Show

This function automatically repeats all pictures in order. 

Operation Display Screen

Use Up/Down Buttons to select the Slideshow 1. 
option. 

Press Menu/OK Button to start the slide show; 2. 
press it again to stop and return to the previous 
page. 
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Section 5 
Setting Your Camcorder 

Setting Menu

Setting Option Display Screen

In Record Mode, press Menu/OK Button to enter 1. 
record menu screen.

Use Right/Left Buttons to select Setting.2. 

The Setting Submenu contains 7 options for 3. 
configuring your camcorder set up. They are 
Sound (operation sound),Information,Time 
Setting,Format,TV,Language,and Default Setting.

Sound

Enable or disable KeyPad tone and operation sound.

Operation Display Screen

In setting Submenu, press Down Button to go to 1. 
the Sound menu. 

Use Right/Left Buttons to choose On or Off. 2. 

Press Menu/OK Button to validate the setting.3. 

Information
To change Information setting by either hot key (Up Button) or Option Setting:

On: Show the indicator(s) on the LCD screen.

Off: Do not show the indicator(s) on the LCD screen.

In setting Submenu, press Down Button to go to 1. 
the Information menu. 

Use Right/Left Buttons to choose On or Off. 2. 

Press Menu/OK Button to validate the setting.3. 
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Time Setting

Operation Display Screen

In setting Submenu, press Down Button to go to 1. 
the Time Setting menu. 

Move between Date and Time by using Up/2. 
Down Buttons. Adjust date and time by using 
Left/Right Buttons.

Press OK Button to validate the setting. Or Press 3. 
RECORD/PLAY button to leave Time Setting 
without any change.

Format 

Yes: Format the built-in memory ( When there is no SD Card in the camcorder ) / SD Card (When there 
is an SD Card in the camcorder). 

No: Do not format the built-in memory ( When there is no SD Card in the camcorder ) / SD Card (When 
there is an SD Card in the camcorder).

Operation Display Screen

In setting Submenu, press Down Button to go to 1. 
the Format menu. 

Press Menu/OK Button to go to the Format 2. 
confirmation screen.

Use Right/Left Buttons to choose Yes or No.3. 

Choosing “Yes” will execute the operation, “No” 4. 
will cancel the operation. 

Press Menu/OK Button to validate the setting.5. 

 Note
All the data will be erased if the SD card is formatted. Make sure all the data are backed-up to PC 
before formatting SD card.
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TV

Ensure that the appropriate TV standard of your area is selected – either NTSC or PAL.

Wrong TV system setting may cause image flicker.

NTSC standard: USA, Canada, Japan, South Korea and Taiwan etc.

PAL standard: UK, Europe, China, Australia, Singapore and Hong Kong etc.

Operation Display Screen

In setting Submenu, press Down Button to go to 1. 
the TV menu. 

Use Right/Left Buttons to choose NTSC(60Hz) 2. 
or PAL(50Hz). 

Press Menu/OK Button to validate the setting.3. 

Language

Use this option to select the language of user interface which you want. 

Operation Display Screen

In setting Submenu, press Down Button to go to 1. 
the Language menu. 

Use Right/Left Buttons to choose the language 2. 
options. 

Press Menu/OK Button to validate the setting.3. 



30
EN

Default Setting

To restore the default factory setting, select this option. 

Operation Display Screen

In setting Submenu, press Down Button to go to 1. 
the Default Setting menu. 

Press Menu/OK Button to go to the Default Setting 2. 
confirmation screen.

Use Right/Left Buttons to choose Yes or No.3. 

Choosing “Yes” will execute the operation, “No” 4. 
will cancel the operation. 

Press Menu/OK Button to validate the setting.5. 

  

The following table indicates the Camcorder’s default setting 

Setting Default Factory Setting

Resolution HD (1080p) for Movie

Standard for Picture

Light Off

Self-timer Off

Scene Auto

Exposure 0EV

WB (White Balance) Auto

Sound On

Information On

TV Depends on shipping area

Language Depends on shipping area

Volume Level 12

Macro Normal

Stabilization Off
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Section 6 
 Viewing Pictures and Movies on a TV

Connecting to a High-Definition 16:9 (Wide) TV

Connect one end of the HDMI cable to your Camcorder’s HDMI Out port.1. 

Connect the other end of the cable to a television.2. 

Set video input source of a TV to “ HDMI” option.3. 

The steps for viewing stored pictures and movie on a TV are exactly the same as for viewing them 4. 
on the LCD monitor.

( 16 : 9 )

 Note
The camcorder can not run movie recording and picture taking when it is connected to an HDTV. 
The LCD Panel does not display when the camcorder is connected to an HDTV.

Connecting to a non-high-definition 4:3 TV

Connect one end of the AV cable to your Camcorder’s AV In port.1. 

Connect the other end of the cable to a television.2. 

The steps for viewing stored pictures and movie on a TV are exactly the same as for viewing them 3. 
on the LCD monitor.

 Note
The LCD Panel does not display when the camcorder is connected to a TV.

( 4 : 3 )



32
EN

Section 7 
 Viewing Pictures and Movies on PC

Installing Bundled Software

The CD-ROM supplied with this Camcorder contains 2 pieces of software. 

ArcSoft MediaImpression • is a user-friendly application that helps you managing your media, burning 
your video into DVD, and uploading your videos to YouTube easily.

Adobe Reader•  is a popular program that you need to have installed to read the User’s Manual. Many 
computer users will find they already have this software installed on their computer.

To install the bundled software:

Insert the CD-ROM into your computer’s CD-ROM drive. The autorun screen appears.1. 

Click 2. Install Application Software. Follow the on-screen instructions to complete the installation. 

 Note
The detailed information can be found in online help of all the bundled software.

Transferring Data to a Computer

You can transfer pictures or movies stored on your Camcorder to a computer and send them in emails 
to friends or post them on websites.

To do this you should:

Connect the computer and Camcorder with the supplied mini USB 2.0 cable. The LED will light up 1. 
and blink.

After the LED stops blinking, movies and picture(s) can be found on your computer at “My Computer\2. 
Removable Disk\DCIM\100MEDIA”.

Under this folder, you can view, delete, move, or copy any movie/picture you want.3. 

Use the bundled ArcSoft application software to edit the movies or pictures.4. 
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Section 8 
 Burning the Recorded Clip into DVD

Bundled software CD contains ArcSoft MediaImpression features burning the movie clip into DVD. You 
can share this DVD movie with family and friends by using regular DVD player. 

To create a DVD:

Install ArcSoft MediaImpression (Refer to Section 7)1. 

Click Windows [ Start ] 2. g[ (All) Programs ]  g[ ArcSoft MediaImpression ]   

ArcSoft MediaImpression main screen will appear on your desktop3. 

Click [ Make Movie ] 4. 



34
EN

The operation screen will appear:5. 

Select the folder that contains the video files you want to burn.• 

Select the file(s) • 

Click button to add the files into slide• 

Click [Burn to Disc] • 

1 2

3

4

1 2

3

4

Click [ Start ] to start DVD burning.6. 
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Section 9 
 Uploading Video Files to YouTube

Bundled software CD contains ArcSoft MediaImpression features uploading the recorded  videos to 
YouTube. It will help you to share them with your family and friends on YouTube website. 

 

To upload video files to YouTube:

Install ArcSoft MediaImpression (Refer to Section 7)1. 

Click Windows [Start] 2. g [ (All) Programs ] g[ ArcSoft MediaImpression ]   

ArcSoft MediaImpression main screen will appear on your desktop3. 

Click [ Video] Option4. 
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Select the video file you want to upload and click [ Upload to YouTube] option at the bottom menu.5. 

If  this is your first using of this function, please follow the  instruction on YouTube Setting Panel. 6. 
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Go to http://www.youtube.com/login, then log onto your YouTube account.7. 

(If you do not  have YouTube account, sign up here first.)

After you log onto your YouTube account, Click [ Get Authorization ] button below.8. 
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  Then, Click  [Allow] Button shown on YouTube website.

Click [Save] Button to upload the video. 9. 
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Section 10 
 Specifications

Specification

Image Sensor 5 Mega Pixel CMOS Sensor

Operation Modes Movie Record, Picture Record

Lens f=6.8 ~ 34mm; F3.5 ~3.7

Focus Range Macro: 1 ~ 80cm 

Normal: 10cm ~ infinite

Zoom HD(1080p):1X~10X (5X Optical + 2X Digital)  .

Other video resolution:1X~20X (5X Optical + 4X Digital)

Shutter Electronic

LCD monitor 2.5”LCD 

Storage Media Built-in 128MB Memory (partial memory is used for Firmware code);

SD Card Slot support

Image Resolution High 3200x2400 (8M Pixels)

Std 2592x1944 (5M Pixels) 

Low 2048x1536 (3M Pixels)

Movie Resolution HD(1080p) 1440X1080(30fps)

HD(720p) 1280X720(30fps)

WVGA 848X480(60fps)

VGA 640X480(30fps)

QVGA  320X240(30fps)

White Balance Auto/Manual (Daylight, Fluorescent, Tungsten)

Exposure Auto/Manual

Self-timer 10 second delay

Light On/Off

File Format Picture: JPG

Movie: MOV

Image play Single Image/Slideshow

PC Interface Mini USB 2.0 Port

TV out NTSC/PAL Selectable, HDMI

Battery Lithium-ion Rechargeable Battery

Dimension 104(H) * 82(W) * 38(D) mm

Weight 119g (without battery)
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Section 11 
 Troubleshooting

Troubleshooting 

1.If the LCD image is not clear when shooting, how can the focus be adjusted?

Taking photos and the object is within 80 cm, use Macro Mode which is the Submenu of Effect Mode.   

2.The light is not working.

The battery power is low.

3.The files on the memory card do not display smoothly when the LCD shows the “!” marking.

The “!” means the SD card is low speed or having wrong content inside. The way to solve this condition 
is to format SD card by camcorder instead of PC (Please refer to the detail Format instruction in Section 5).

4.Why do some of my indoor pictures look blurry and dark?

Camcorder extends pictures exposure time under low light/ indoor condition. Keep camcorder (and

photographed subject) steady for several seconds when taking pictures. Shutter will sound when picture

has been taken.

5.How do I charge battery?

Computer will not charge battery when connected. You must use ONLY the supplied AC charger.

Camcorder must be turned OFF; blinking light confirms charging, but light is constant when charging

has been completed.
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Section 12 
 Other Information

TOSHIBA Support

Need help?

For the latest driver updates, user's manuals & FAQ's please have a look at the

TOSHIBA options & services support page: 

computers.toshiba.eu/options-support

Please see  computers.toshiba.eu/options-warranty

for the TOSHIBA hotline numbers.

Operating Environment Conditions

Operating temperature: 5 to 35° C

Operating humidity: 20 to 80 %

(no condensation allowed)

Regulatory Information

CE compliance

This product is CE marked in accordance with the requirements of the applicable EU Directives. 
Responsible for CE marking is Toshiba Europe GmbH, Hammfelddamm 8, 41460 Neuss, Germany. A 
copy of the official Declaration of Conformity can be obtained from following website: 

http://epps.toshiba-teg.com .

Working Environment

The Electromagnetic Compliance (EMC) of this product has been verified typically for this product 
category for a so called Residential, Commercial & Light Industry Environment. Any other working 
environment has not been verified by Toshiba and the use of this product in these working 
environments is maybe restricted or cannot be recommended. Possible consequences of the use of 
this product in non verified working environments can be: Disturbances of other products or of this 
product in the nearby surrounding area with temporarily malfunction or data loss/corruption as result. 
Example of non verified working environments and related advices:

Industrial environment (e.g. environments where a mains voltage of 380V three-phase is being used 
mainly): Danger of disturbances of this product due to possible strong electromagnetic fields especially 
near to big machinery or power units.

Medical environment: The compliance to the Medical Product Directive has not been verified by 
Toshiba, therefore this product cannot be used as a medical product without further verification. The 
use in usual office environments e.g. in hospitals should be no problem if there is no restriction by the 
responsible administration.
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This product is not certified as a medical product according to the Medical Product Directive 93/42 
EEC.

Automotive environment: Please search the owner instructions of the related vehicle for advices 
regarding the use of this product (category).

Aviation environment: Please follow the instructions of the flight personnel regarding restrictions of 
use. 

Additional environments not related to EMC

Outdoor use: As a typical home/office equipment this product has no special resistance against ingress 
of moisture and is not strong shock proofed. 

Explosive atmosphere: The use of this product in such special working environment (Ex) is not 
allowed.

Following information is only valid for EU-member states:

Disposal of products 

The crossed out wheeled dust bin symbol indicates that products must be collected 
and disposed of separately from household waste. Integrated batteries and 
accumulators can be disposed of with the product. They will be separated at the 
recycling centres. 

The black bar indicates that the product was placed on the market after August 13, 
2005.

By participating in separate collection of products and batteries, you will help 
to assure the proper disposal of products and batteries and thus help to prevent potential negative 
consequences for the environment and human health. 

For more detailed information about the collection and recycling programmes available in your country, 
please visit our website (http://eu.computers.toshiba-europe.com) or contact your local city office or 
the shop where you purchased the product.

Disposal of batteries and/or accumulators

The crossed out wheeled dust bin symbol indicates that batteries and/or accumulators must be 
collected and disposed of separately from household waste.

If the battery or accumulator contains more than the specified values of lead (Pb), 
mercury (Hg), and/or cadmium (Cd) defined in the Battery Directive (2006/66/
EC), then the chemical symbols for lead (Pb), mercury (Hg) and/or cadmium (Cd) 
will appear below the crossed out wheeled dust bin symbol. 

By participating in separate collection of batteries, you will help to assure the 
proper disposal of products and batteries and thus help to prevent potential 
negative consequences for the environment and human health. 

For more detailed information about the collection and recycling programmes available in your country, 
please visit our website (http://eu.computers.toshiba-europe.com) or contact your local city office or 
the shop where you purchased the product.

    Pb,Hg,Cd
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Additional Information

© 2008 TOSHIBA Europe GmbH. All rights reserved.

TOSHIBA reserves the right to make technical changes. TOSHIBA assumes no liability for damages 
incurred directly or indirectly from errors, omissions or discrepancies between this product and the 
documentation.
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For further options & services see:
computers.toshiba-europe.com

0970A8374L-A01F


